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About This Guide

This guide describes the Deployment Configuration Program for the Sun Java™

System Connector for Microsoft Outlook. Topics covered in this chapter include:

• Who Should Read This Book
• What You Need to Know
• How This Book is Organized
• Document Conventions
• Where to Find Related Information
• Where to Find This Book Online

Who Should Read This Book
You should read this book if you are responsible for administering and deploying
Sun Java System Connector for Microsoft Outlook at your site.

What You Need to Know
This book assumes that you are responsible for administering and deploying the
Connector for Microsoft Outlook software and that you have a general understand-
ing of the following:

• The Internet and the World Wide Web
• Messaging Server and Calendar Server protocols
• System Administration and Networking on the following platforms:

❍ Microsoft Windows 2000
❍ Microsoft Windows XP
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• Microsoft Outlook
• General Deployment Architectures

How This Book is Organized
This Reference Manual contains the preface you are now reading, followed by three
chapters:

• Chapter 1, “Getting Started”—Brief narrative explanations of what the Sun
Java System Connector software is designed to do, how it is typically used
within the broader context of an overall migration scenario, and what an ad-
ministrator should do to get started with the software — plus instructions for
installing the administrator’s software on the administrator’s own computer.

• Chapter 2, “Creating End-User Installation Packages”—This chapter describes
how to use the Deployment Configuration Program to create customized in-
stallation packages for Outlook end users. These packages can be configured to
install the necessary software, or to convert existing Outlook and Exchange
data files for use with the new Connector for Microsoft Outlook, or both—de-
pending on your circumstances.

• Chapter 3, “Application Notes for Special Circumstances”—This chapter ex-
plains how to deploy the Sun Java System Connector for Microsoft Outlook
under certain special circumstances or network configurations:

❍ “Push” Method Deployment, If End Users Lack Installation Privileges: In-
stallation of software to an end user’s desktop requires access privileges
that often are disallowed to many or most end users. Most organizations in
these circumstances implement a “push” method of software distribution
from the system administrator to user desktops, which bypasses the re-
quirement for user access privileges. If your network serves
“locked-down” Windows environments where end users cannot install
software, we strongly recommend this sort of automated configuration
management as a way to avoid many individual desktop visits.

❍ Command-Line Switches for the User Installation Package: A user-installa-
tion package can be run from the command line, with switches to pass the
necessary user passwords to the conversion program as it runs. An instal-
lation package can therefore be run by an SMS script, with command-line
switches, to make possible a truly silent installation and configuration, re-
quiring no user interaction whatsoever.



About This Guide 9

❍ Migrating Terminal Service Users from Exchange to the Sun Java System:
The Sun Java System Connector administrator’s tools can also be used to
migrate existing Outlook users of Windows terminal service from Ex-
change to a Sun Java System server.

❍ To Designate Microsoft Outlook as a User’s Default E-mail Client: Installa-
tion of the Sun Java System Connector software requires that Outlook be
set as the default e-mail client for every user. If a user does not have Out-
look set as his or her default client, he or she (or an administrator) should
follow the instructions in this section to reset the default to Outlook.

❍ To Remove the Sun ONE Sync Program from a User’s Workstation: The
Sun Java System Connector software cannot coexist on the same desktop
with the Sun ONE Sync program. If the Sun ONE Sync program has been
installed on a user’s desktop, the user (or an administrator) should follow
the instructions in this section to remove it.

❍ Undoing (Reversing) a User’s Migration: How to abandon a user’s connec-
tion to the new Sun Java System server and restore the user’s mailbox to
service with the old Exchange server.

❍ Recovering from a User’s Removal of LDAP Services from Outlook: How
to restore LDAP services to the user’s workstation.

Document Conventions
In this guide, file and directory paths are given in the Windows format (with back-
slashes separating directory or folder names). If you reference other Sun Java Sys-
tem documentation, you may notice that UNIX conventions designate file and
directory paths (with front slashes separating directories).

• Monospaced font is used for any text that appears on the computer screen or
text that you should type. It is also used for filenames, distinguished names,
functions, and examples.

• Bold monospaced font is used to represent text within a code example that you
should type.

• Italicized font is used to represent text that you enter using information that is
unique to your installation (for example, variables). It is used for server paths
and names.

For example, you might see path references of the form:

ISTOREx.LOG
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In this situation, x is a numerical value for the day of the week.

Italicized font is also used for variables within the synopsis of a command line
utility. For example, the installation package supports the command line
utility:

/USERNAME=xxx

In the above example, the italicized font is an argument for its associated
command. The xxx refers to the UserID on the server.

• Square (or straight) brackets [] are used to enclose optional parameters. For
example, you may see the usage for the setup command described as follows:

installer [options] [arguments]

It is possible to run the installer command by itself as follows to start the
Messaging Server installation:

setup

However, the presence of [options] and [arguments] indicate that there are
additional optional parameters that may be added to the setup command. For
example, you could use setup command with the -k option to keep the
installation cache:

setup -k

Where to Find Related Information
For more information about the Deployment Configuration Program and the sys-
tem administrator’s role in the deployment of the Sun Java System Connector for
Microsoft Outlook, please see:

• Sun Java System Connector for Microsoft Outlook Desktop Deployment Ad-
ministrator’s Guide: The Desktop Deployment Administrator’s Guide provides a
more global overview of the deployment process, explaining several strategic
and high-level tactical options that a system administrator should consider pri-
or to actual deployment. As you prepare user installation packages, you will
encounter many available choices that let you determine how the new software
will be distributed, installed and configured on user desktops. Some of your
choices will be dictated by logistical imperatives, while others will be judg-
ment calls, derived from your personal familiarity with your organization,
your network, and your users. The Desktop Deployment Administrator’s Guide is
intended to help you anticipate all such choices, to help you understand the
significance and implications of each option.
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We strongly recommend that you read the Desktop Deployment Administrator’s
Guide before you start using the Deployment Configuration Program to prepare
user installation packages.

• Online Help: A context-sensitive online Help file accompanies the Deploy-
ment Configuration Program. From any screen or tab within the software, sim-
ply click the Help button or press F1 to open a Help window and view
pertinent information about the displayed screen or tabbed panel.

Documentation for Sun Java System Connector for Microsoft Outlook can be found
at the following URL:

http://docs.sun.com/coll/ConnectorMSO_60

Where to Find This Book Online
You can find the Sun Java System Connector for Microsoft Outlook Desktop Deploy-
ment Configuration Program Reference Manual online in PDF and HTML formats.
This book can be found at the following URL:

http://docs.sun.com/db/doc/817-4219
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Chapter 1

Getting Started

Introduction and Orientation
Your organization will use the Sun Java System Connector for Microsoft Outlook
so that your users can use Microsoft Outlook as their e-mail and calendar client
while connected to Sun Java System servers. The software must be installed and
configured on each user desktop to facilitate the necessary ongoing communica-
tions between Outlook and the Sun Java System server. The Connector for Mi-
crosoft Outlook software is installed one desktop at a time by a Setup Wizard that
can also convert any existing Outlook data files to a format that the new software
can read and use.

To simplify both the administrator’s work associated with deployment and the us-
er’s tasks in actually installing and configuring the new software, Sun provides a
Deployment Configuration Program. This tool lets the administrator create cus-
tomized end-user installation packages for the software, with pre-set configuration
parameters to simplify and streamline the user’s process, and to enforce any con-
figuration settings the administrator deems necessary or desirable for a particular
user or group of users. The Deployment Configuration Program saves those pre-set
configuration parameters in an .ini text file, and then bundles the .ini file with an
installation program—the Setup Wizard—for end users. When an end user acti-
vates the package, the Setup Wizard reads the .ini file to install and configure the
Connector software on his or her desktop according to the administrator’s specifi-
cations.

A system administrator may create different installation packages for different in-
dividual users, or for different groups of end users—for example, to enforce differ-
ent configuration schemes for users in the Sales department vs. the Engineering
department and so forth, or to offer configuration options to some groups of users
while setting fixed parameters (eliminating the choices) for others.



Administrator’s Process Overview

14 Connector for Microsoft Outlook 6.0 • Desktop Deployment Configuration Program Reference Manual • February 2004

Administrator’s Process Overview
In a typical deployment scenario, an administrator will perform these four primary
tasks to deploy the Sun Java System Connector for Microsoft Outlook:

1. Install the Sun Java System Connector for Microsoft Outlook software. Sun’s
administrative software obviously must reside on the administrator’s comput-
er before it can be used to create end-user installation packages. The installa-
tion instructions appear below, in the last section of this chapter 1.

2. Prepare a comprehensive Deployment Plan. Planning and foresight are criti-
cal to a smooth deployment. The process of developing a comprehensive De-
ployment Plan is a valuable exercise that will force you to consider and
accommodate all of the factors likely to influence your organization's migra-
tion. The Desktop Deployment Administrator’s Guide that accompanies this Ref-
erence Manual explains important migration concepts, prerequisites, and
strategic choices, and explains how to develop a Deployment Plan that will
guide you through your migration. Every administrator should therefore read
the Desktop Deployment Administrator’s Guide and prepare a comprehensive
Deployment Plan.

3. Prepare an end-user installation package. Chapter 2, “Creating End-User In-
stallation Packages” explains how to use the Deployment Configuration Pro-
gram to create customized installation packages for Outlook end users. These
packages can be configured to install the necessary software on user desktops,
or to convert users’ existing Outlook and Exchange data files for use with the
new software—or both, depending on your circumstances.

4. Deploy each end-user installation package. Once you have created an instal-
lation package for your users, you must tell them where to find it and how to
use it. Many administrators simply copy the installation package and the asso-
ciated Desktop Installation Guide to a shared folder, and then provide links to the
installation package and documentation in an announcement e-mail to users.

Step 1 and Step 2 of this process overview are a good place to start regardless of
your unique configuration and preferences. If your migration strategy calls for two
or more different installation packages for different users or user groups, simply
repeat Step 3 and Step 4 for each package until all users have been migrated.

The deployment process can proceed along different paths depending on your
original and destination network configurations, the administrative structure of
your organization, and your own informed sense of the extent to which your users
should be involved in the process of installing and configuring their own desktop
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software. Moreover, your network configuration or preferences may dictate some
variation to the standard scenario described above. Chapter 3, “Application Notes
for Special Circumstances”provides application notes for the most common of
these variations.

Installing the Administrator’s Software
If the most recent version of the Sun Java System Connector for Microsoft Outlook
Administrator’s software is not already installed on your computer, you must in-
stall it before you can create end-user installation packages:

1. Locate the Sun Java System Connector for Microsoft Outlook setup file,
Setup.exe, that you have downloaded or otherwise copied to your computer.
Double-click the filename to start the program.

The InstallShield Wizard then welcomes you to the process and prompts you
to click the Next button to continue, as shown in Figure 1-1.
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Figure 1-1 The InstallShield Wizard Welcome Screen

2. Click the Next button.

The InstallShield Wizard then prompts you to enter your customer
information, as shown in Figure 1-2.
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Figure 1-2 InstallShield Wizard: Customer Information

3. Enter your User Name and Organization, and choose whether you want the
Connector for Microsoft Outlook software to be available to all users of this
computer, or only to your User Name. Then click Next.

The InstallShield Wizard then asks whether you want to perform a Complete
or Custom installation.

4. Choose the Complete installation option, and click Next.

The InstallShield Wizard then announces that it is ready to begin the actual
installation, and prompts you to click Next to begin.

5. Click the Next button, and wait for the installation to proceed and conclude. (A
progress meter appears in the window while you are waiting.)

The InstallShield Wizard notifies you when the process is complete, and
prompts you to click the Finish button.
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6. Click Finish.

As the InstallShield Wizard exits, it opens a browser window to the Sun web
site where you can download the documentation PDF and HTML files.

The Connector for Microsoft Outlook administrator’s software (filename
Admin.exe) has now been installed to:

C:\Program Files\Sun\Deployment Configuration Program\

A new shortcut icon for the Admin.exe program appears on your desktop.
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Chapter 2

Creating End-User Installation Packages

If the most recent version of the Administrator’s software is not yet installed on
your computer, see “Installing the Administrator’s Software” in Chapter 1. The
Administrator’s software must be properly installed on your computer before you
can run the Deployment Configuration Program.

These instructions define a procedure to create a single desktop installation
package for a single user, or for a particular group of users who will all install and
configure the Connector for Microsoft Outlook in the same way. To create two or
more desktop installation packages with a variety of configuration settings for
different groups of users, simply repeat this procedure for each package you want
to create.

To create an end-user desktop installation package:

1. Locate and launch (double-click) the file Admin.exe, in C:\Program
Files\Sun\Deployment Configuration Program\, or from a desktop
shortcut icon or the Start program menu.

The Deployment Configuration Program then opens its Configuration Win-
dow on your desktop, as shown in Figure 2-1.

Figure 2-1 Deployment Configuration Program: Configuration Window

The Configuration Window contains:
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❍ eight tabbed panels where you will enter the information to characterize
an end user’s configuration of the Sun Java System Connector (described
separately below).

❍ a Help button, which opens a separate window of information about the
entry options available on the currently displayed panel.

❍ three menus: File, Tools and Help.

The File Menu and Help Menu offer several standard, familiar Windows fea-
tures for file management, and context-sensitive access to the online Help sys-
tem that accompanies this Deployment Configuration Program:

❍ File Menu: New, Open..., Save, Save As..., Print Setup..., Print..., and Exit.

❍ Tools Menu: Create Package.

❍ Help Menu: Deployment Help, and About the Deployment Configuration
Program.

The Create Package option on the Tools Menu lets you create a new installa-
tion package for an existing .ini configuration file that has been opened into
this Configuration Window. You may use File > Open... to locate and open an
existing .ini file.

2. Complete the information in the eight tabbed panels, as described separately
(per tab) below. Click on each tab to display the associated panel.

If you begin creating an installation package but then decide to finish it at a
later time, you may File > Save a partially completed package, and then File >
Open... it later to resume and complete your work.

3. When you have entered all of the information requested in all eight tabbed
panels, select File > Save to save your configuration choices in an .ini file and
create a new installation package. Your Save command activates a standard,
familiar Windows Save dialog box.

4. In the dialog box: Enter an appropriate filename and path for the .ini file and
.exe file, and click the Save button.

If the program reports a Logon failure or “Could not locate...” a necessary re-
source while it is running. If you know that the resource exists in the location
you have specified, then the administrator account you are using to run this
Deployment Configuration Program is not authenticated to the file server
where the resource resides. Make sure that you are logged in to the locations of
all such resources and then run the Deployment Configuration Program again.
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The Save command actually creates two new files: the .ini file, which is saved to
whatever folder you designate in the Save dialog box, and an .exe file (the
bundled installation package, including a copy of the .ini file), which is saved by
default to C:\Program Files\Sun\Deployment Configuration
Program\Packages. Both the .ini and .exe files carry whatever filename you
designate in the Save dialog box.

Processes Tab
The Processes Tab is shown in Figure 2-2.

Figure 2-2 Deployment Configuration Program: Processes Tab
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User mode
These two options, Silent installation vs. Interactive, are mutually exclusive:

Silent: The user program will install and configure the user’s software, and convert
the existing default Exchange user profile and existing Personal Folders (.pst)
files, without any user involvement whatsoever, according to the administrator’s
pre-set parameters for this process (as set in this and the other tabs in this
Deployment Configuration Program).

Interactive: The user program will present the user with at least some choices for
the installation, configuration and conversion processes. The extent of user
involvement will be as determined by the administrator (as set in this and the other
tabs in this Deployment Configuration Program).

Processes to include in this configuration
The installation of these software components to user desktops will require access
privileges that often are disallowed to many or most end users. If your network
serves “locked-down” Windows environments where end users cannot install
software, we strongly recommend a “push” method for software distribution from
the system administrator to user desktops that bypasses the requirement for user
access privileges. This “push” method of distribution is explained in Chapter 3
““Push” Method Deployment, If End Users Lack Installation Privileges.”

For a full explanation of any or all of the processes offered in this panel, and the
implications of installing or not installing them, please see “Deployment Toolkit
Components” in chapter 1 of the Desktop Deployment Administrator’s Guide.

Install or upgrade Sun Java System. Tells the user program to install the software
that facilitates the necessary ongoing communications between the user’s Outlook
client application and the Sun Java System server(s). If Sun Java System Connector
for Microsoft Outlook is already installed, the user program will check the installed
version and, if appropriate, upgrade to the newer version.

The Sun Java System Connector for Microsoft Outlook system requirements
include:

• Operating System Windows 2000 or Windows XP.

• Outlook 2000 with Office 2000 Service Pack 3 or higher, or Outlook 2002 with
Office XP Service Pack 2 or higher.
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• Microsoft Outlook must be designated as the user’s default e-mail client. If
Outlook is not set as a user’s default e-mail client, see “To Designate Microsoft
Outlook as a User’s Default E-mail Client” in Chapter 3 for instructions to
resolve this problem.

• The software cannot be installed to any workstation that also contains the Sun
ONE Sync program, which is incompatible with Connector for Microsoft
Outlook. If the Sun ONE Sync program has been installed on a particular user’s
desktop, it must be removed (see “To Remove the Sun ONE Sync Program
from a User’s Workstation”, in Chapter 3 for instructions).

The Sun Java System Connector for Microsoft Outlook Setup Wizard will detect
any discrepancy between these requirements and the actual installation
environment, and in that case will not install Sun Java System Connector for
Microsoft Outlook.

Install or upgrade Microsoft Web Publishing Wizard. Tells the user program to
install Microsoft’s Web Publishing Wizard (WPW), which makes the user’s
Free/Busy information available to the Sun Java System Calendar Server. If WPW
is already installed, the user program will check the installed version and, if
appropriate, upgrade to the newer version.

<Enter shared path to web kit>. Specify the network location of the installation kit
for the Web Publishing Wizard.

Install or upgrade Microsoft LDAP Service. Tells the user program to install the
LDAP component of Outlook 2000, which will facilitate communications between
Connector for Microsoft Outlook and the Sun Java System directory. If the LDAP
component is already installed, the user program will check the installed version
and, if appropriate, upgrade to the newer version. This component is required only
if some of your users are using Outlook 2000, and is not required if all users are
running Outlook 2002. Connector for Microsoft Outlook uses LDAP services to
communicate with the Sun Java System directory, and the LDAP protocol is a
standard feature of Outlook 2002. The LDAP protocol is only an optional feature in
Outlook 2000, not a part of a “standard” Microsoft Office installation. If any of your
users are using Outlook 2000 you will need the corresponding original Microsoft
installation CD(s) or files to install the LDAP component. These kits are not
included in the Desktop Deployment Toolkit package because they are Microsoft
products. For more information, see “Deployment Toolkit Components” in the
Desktop Deployment Administrator’s Guide.
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<Enter shared path to LDAP kit>. Specify the network location of the installation
files for the version of Outlook 2000 used by these users.

Create/convert user profile. Activates the User Profiles tabbed panel, so the user
program can convert an existing eligible Outlook user profile or create a new
profile for use with the new Sun Java System Connector. The user program will
convert only an “eligible” profile, meaning that the profile must:

• include Microsoft Exchange Server message services

• not have been fully converted (all of its .pst files converted) by a previous run
of the user program (although the remaining, unconverted .pst files of a
partially converted profile can be converted).

If this box is not marked, the entire User Profiles panel will be grayed out and
unavailable, and no user profile will be converted or created. For example, you
may want to create a user installation package to simply install or update MAPI
services without converting or creating any profiles.

Log file settings
These settings pertain to the directory where the user program will write its log
files for the user’s migration session. The first two radio-button options are
mutually exclusive:

• Store log files locally: Tells the user program to write its log files to the user’s
local “temp” directory.

• Store log files in a shared directory: Tells the user program to write its log files
to a particular shared directory:

NOTE If the Browse feature for LDAP does not display the location you
need to specify (but you know that it exists).This is an unlikely
scenario, but chances are you simply are not authenticated in the
domain to which you have browsed. To correct this problem,
right-click the target computer and select Explore, and then enter
your administrator userID and password at the prompt. You may
then return to the Browse feature and select the computer you need
to browse.
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❍ <Enter shared folder for Log files>: Specify the shared folder to contain the
log files. You can enter a drive letter or a UNC path.

If the Browse feature for Log files does not display the location you need to specify (but
you know that it exists): This is an unlikely scenario, but chances are you simply
are not authenticated in the domain to which you have browsed. To correct
this problem, right-click the target computer and select Explore, and then enter
your administrator userID and password at the prompt. You may then return
to the Browse feature and select the computer you need to browse.

• Include debug logging: Tells the user program to log its activities in the more
verbose, more explicit “debug” style. If a user encounters a problem with the
installation package and you can’t diagnose the problem by reviewing the
default-style log entries, the more verbose debug-style logging may provide
enough additional information to help you or your associates solve the
problem. This option is off by default.

Status file settings
Post a one-line status of user activity to a .csv file: Adds a one-line summary of
user activity to the .csv file you specify in the accompanying box (below). Each line
represents one run of the desktop tool by one user. A single user who runs the tool
multiple times should generate multiple lines in the .csv file.

• <Enter shared file for status entries>: Specify the shared file to contain the
status entries. If the file already exists, it will be updated each time the
installation kit is run.

Notes (optional)
Any notes or comments you care to include about this configuration can be added
in this field.

User Profiles Tab
The settings in this User Profiles panel, shown in Figure 2-3, apply only if this
package will create or convert user profiles. Therefore, the features in this panel are
available only if the Create/convert user profile option is checked on the Processes
tabbed panel. This entire User Profiles panel will be grayed out if the
Create/convert user profile option is unmarked.
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The settings in this panel determine how Exchange users’ Contacts, Journal and
Notes data will be converted to local (desktop) Sun Java System Connector
Personal Folders (.pst) files.

Figure 2-3 Deployment Configuration Program: User Profiles Tab

User profile settings
You may mark options in this section to specify whether and how user profiles will
be converted and created:

• Convert existing user profiles: Tells the user program to convert an existing
Outlook profile, as follows:

❍ In Silent Mode: Converts the user’s default profile if it can be found, or
does nothing if a default profile cannot be found.



User Profiles Tab

Chapter 2 Creating End-User Installation Packages 27

❍ In Interactive Mode: Prompts the user to select a single profile to convert
if it finds two or more eligible profiles connecting to Exchange server(s), or
finds only one eligible profile that is not set as the user’s default. If the
program finds only one eligible profile, and it is set as the user’s default,
the program automatically converts that profile without any user
interaction. If the program finds no eligible profiles, it does nothing —
neither converts nor creates any user profile.

Remember that the user program will convert only an “eligible” profile,
meaning that the profile:

❍ must include Microsoft Exchange Server message services, and

❍ must not have been fully converted (all of its .pst files converted) by a
previous run of the user program (although the remaining, unconverted
.pst files of a partially converted profile can be converted).

• Create new user profiles: Tells the user program to create a new Outlook user
profile, ignoring any existing profiles that may already exist for the user. It will
create only one new profile for a given user, even if the user runs the
installation two or more times.

• Convert or Create: Tells the user program to convert an existing Outlook user
profile if it can find one, or create a new profile if it cannot find an existing one:

❍ In Silent Mode: Converts the user’s default Outlook profile if it can be
found, or creates a new profile if a default profile cannot be found.

❍ In Interactive Mode: Prompts the user to select a single profile to convert
if it finds two or more eligible profiles connecting to Exchange server(s), or
finds only one eligible profile that is not set as the user’s default. If the
program finds only one eligible profile, and it is set as the user’s default,
the program automatically converts that profile without any user
interaction. If the program finds no eligible profiles, it creates a new one.

• Name for new profiles: The name by which the new profile will be identified
in the drop-down list box that appears on Outlook’s user logon screen.

• Set new profile as default: If this box is checked, the new profile will be set as
the user’s default Outlook profile.
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Save password options
• Give user the option to save: Tells the user program to display a checkbox that

lets the user choose whether Outlook should prompt the user for a password
upon each login, or save (“remember”) the password so the user can skip that
login step. Within the user program, the instructions displayed with the
checkbox explain: “If checked, you will not need to enter your information
each time you launch Outlook.” This option is not available if this package is
configured to run in Silent mode.

• Always save: Tells the user program to not offer the user the choice described
above (for Give user the option...). Instead, the screen will display this
message: “Your password will be saved. You will not need to enter your
password each time you launch Outlook.”

• Never save: Tells the user program to not offer the password choice, so
Outlook will always prompt for user passwords, by default. The user program
will display no checkbox or related explanatory text.

Personal folder (.pst) file settings
Update ALL addresses to SMTP format: Tells the user program to convert all
addresses that occur within Personal Folders (.pst) files to SMTP (Internet
standard) format.

By default, automatically convert a .pst if file is smaller than: ____ MB: In Silent
mode: The user program will ignore (not convert) any .pst files larger than or
equal to the size specified here. In Interactive mode: If any existing .pst files are
larger than or equal to the specified size, the program will prompt the user to
specify which (if any) of the large files to convert.

Auto-minimize setup wizard and convert .psts in the background, if total size of
all .psts exceeds: ____ MB: This setting is irrelevant in Silent mode. In the
Interactive mode, if the total size of all .pst files to be converted exceeds the size
specified here, the user program will convert the profiles first, and then
automatically minimize itself to the user’s Task Bar to convert the .pst files as a
background process. Once the profile has been converted, the user can run Outlook
and access the converted profile.

Size for new Sun Java System .pst: ____ MB: The expected amount of disk space
required for the new .pst file into which selected items from the old Exchange
server are copied. The user program aborts the conversion if a user does not have
this much disk space available. Leave this value set at its default unless you have
some particular reason to expect that your .psts will be larger.
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Password protected .psts: Choose one of these mutually exclusive options for
converting password protected .pst files:

• Prompt user for password and convert (not an option in Silent mode): Tells
the user program to prompt the user for the password to open each .pst file
and convert it.

• Do not convert but keep old .pst in profile: Tells the user program to not
convert the .pst file, but to keep the unconverted .pst file in the profile.

• Do not convert and remove from profile: Tells the user program to not convert
the .pst file, and to remove the unconverted .pst file from the profile. (The
old .pst file is not, however, physically deleted from the user’s hard drive.)

Servers Tab
The Servers tab is shown in Figure 2-4.
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Figure 2-4 Deployment Configuration Program: Servers Tab

Settings
Server Name: The host name for each Sun Java System server: IMAP, SMTP,
LDAP, Calendar, and Free/Busy.

Use SSL: Mark this box to require an SSL to connect to the associated server.

NOTE If the Use SSL box is not marked for the Calendar server, the
Free/Busy server values will be the same as for the Calendar, and
the Free/Busy line will therefore be grayed out in this panel. But if
Use SSL is marked for the Calendar, then you must specify a
different port for Free/Busy.
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Port: The default port number for each server. The default changes if you use SSL
to connect to the server.

Default: Restores all Port numbers back to their original default values (if you have
changed the values but now want to restore the defaults). The default values for
SSL vs. non-SSL are different, and this feature will restore the appropriate default
for any given server depending on whether the Use SSL box is marked.

IMAP Tab
The IMAP Tab is shown in Figure 2-5.

Figure 2-5 Deployment Configuration Program: IMAP Tab



SMTP Tab

32 Connector for Microsoft Outlook 6.0 • Desktop Deployment Configuration Program Reference Manual • February 2004

Settings
IMAPSP folder name: The name that will appear next to the IMAPSP Folders icon
in the Outlook Folder List. If left unspecified, the Server Name field (from the
Servers tabbed panel in this same Deployment Configuration Program) will appear
as the folder name instead.

Only cache messages that are less than: ____ KB: The per-message size limit for
the IMAPSP local message cache. This option is intended primarily to reduce
download times when the user goes into offline operations. This value, however,
will also affect re-display times in online mode, because the message will need to
be re-retrieved if it has not been cached.

Move deleted messages to folder: The name of the folder for IMAP trash, where
you want deleted messages to be moved.

Check for new messages every: ___ minutes: This is the interval, in minutes, after
which a server mailbox will be polled for newly arrived messages. If any new
messages have arrived, the mailbox is refreshed and redisplayed in Outlook. If this
field is cleared or set to zero, no polling will be done for this server connection.

Options
Enable logging: Causes log, error, and trace information to be sent to a file named
ISTOREx.LOG (where 'x' is a numerical value for the day of week, 1-7) in the PC's
temp(orary) directory. Only the last three days' logs are saved.

Startup offline, by default: Configures IMAPSP to not initially attempt a
connection to the server, so the user will have to execute the Online mode menu to
go online.

Cache inbox when going offline: Configures IMAPSP to cache the Inbox when the
user goes offline. Alternatively, the user can set the caching status of a given
mailbox by highlighting the folder entry in Outlook, then executing the Properties
menu, pressing the IMAPSP tab, and turning on the Cache all message parts
(attachments) for this folder option.

SMTP Tab
The SMTP tab is shown in Figure 2-6.
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Figure 2-6 Deployment Configuration Program: SMTP Tab

Options
BCC all sent messages to self: Configures the user software to automatically insert
the user’s e-mail address into the BCC field of every outbound message (effectively
lets a sender file a copy of every message sent). The messages are filed within a
sender's server INBOX, and subsequently will be affected by any server-based
message filtering rules.

Enable logging: Causes log, error, and trace information to be sent to a file named
ISSMTPx.LOG (where 'x' is a numerical value for the day of week, 1-7) in the PC's
temp(orary) directory. Only the last three days' logs are saved.

Requires authentication: Tells the user software to configure the SMTP Service so
as to require user authentication for outbound SMTP mail.
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LDAP Tab
This LDAP tabbed panel, shown in Figure 2-7, lets you specify the settings for the
Outlook LDAP Directory Service.

Figure 2-7 Deployment Configuration Program: LDAP Tab

Settings
Search base: The LDAP distinguished name of the root of your LDAP directory.
For example, if the top level of your directory is o=florizel.com and your address
book in the organizational unit is named ou=People, then your search base should
be set as ou=People,o=florizel.com.

Search times out after: ___ minutes: Limits directory search times to the
designated number of minutes.
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Maximum number of search results returned: Limits the number of entries
returned by a search to the number specified here.

Require authentication: Tells the user software to configure the LDAP Directory
Service so as to require user authentication in the form of a user Distinguished
Name (DN) for each directory query.

• User DN pattern: The elements of the user’s Distinguished Name (DN) that,
when assembled, will form the complete DN to authenticate the user’s identity
to the LDAP Directory Service (if authentication is required). For example, to
define a DN consisting of a user ID (uid), an organization unit (ou) and an
organization (o): uid=%S,ou=people,o=florizel.com

Similarly, to define a DN consisting of a common name, an organization and a
country: cn=Fred Smith,o=florizel.com,c=US

Calendar Tab
The Calendar tab is shown in Figure 2-8.
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Figure 2-8 Deployment Configuration Program: Calendar Tab

Settings
Sync Outlook calendar with calendar server every: ___ minutes: Specifies how
often the Outlook calendar will synchronize with the calendar server.

Single User Tab
The Single User tabbed panel, shown in Figure 2-9, lets you specify and
authenticate the identity of a single specific user. This panel applies only if you are
creating an installation kit for one particular user.
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Figure 2-9 Deployment Configuration Program: Single User Tab

Settings
Full name: The “friendly” name associated with the user's e-mail address. When
sending messages, this name appears in the From box of the user's outgoing
messages.

E-mail address: Specifies the e-mail address that people should use when sending
mail to the user at this account — must be in the format name@florizel.com.

Login name: Specifies the user's account name, which must be the same value for
both the IMAP and calendar servers. This is often the same as the part of the user's
e-mail address to the left of the “at” sign (@).

Password: The user's account password, which must be a single shared password
used for both the IMAP and calendar servers.
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Password confirm: A duplicate field for the user’s account password, required as a
precaution against typographical errors. (This value must match the Password
value above.)
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Chapter 3

Application Notes
for Special Circumstances

“Push” Method Deployment, If End Users Lack
Installation Privileges

The Deployment Configuration Program allows an administrator create
installation packages that end users can run to install and configure their own local
desktop copies of the Connector for Microsoft Outlook software. Software
installation, however, requires access privileges that often are disallowed to many
or most end users. Most enterprises therefore implement a “push” method for
software distribution from the system administrator to user desktops that bypasses
the requirement for user access privileges. If your network serves “locked-down”
Windows environments where end users cannot install software, we strongly
recommend this sort of automated configuration management as a way to avoid
many individual desktop visits.

This section describes a “push” method for distributing the Sun Java System
Connector for Microsoft Outlook to user desktops using Microsoft's SMS
administration tools. Remember that the Deployment Configuration program can
prepare desktop installation packages that both install the Connector for Microsoft
Outlook software and convert existing Outlook profiles and data files for use with
the new software. If your users had sufficient administrator privileges to install
new software on their own desktops, you could prepare a single installation
package that would perform both the installation and conversion functions in a
single pass. But if the user who runs the installation package lacks the
administrator privileges to install software, then the installation portion of the
package would be unable to run and the conversion would fail.

When users cannot install their own software, we have to separate those two tasks
so that the installation function can be facilitated separately by an SMS installation
package. The SMS installation package can then be run on each user desktop by a
local SMS account that has full administrator rights, and is therefore authorized to
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install new software on the local desktop. After the necessary software for
theConnector for Microsoft Outlook has been installed, we use the Deployment
Configuration Program to prepare a second installation package to convert any
existing Outlook profiles and data files for use with the new Connector for
Microsoft Outlook.

The conversion functions will convert any existing Outlook profiles and data files
associated with the specific user who is running the desktop installation program.
But the SMS account that will run the first installation package is a generic account,
with administrator privileges so that it can install software, but not associated with
any particular user. The installation tasks and conversion tasks must therefore be
performed by two separate installation packages, because the generic SMS account
necessary to physically install the software lacks the user specificity necessary to
convert a user’s existing profile and data files.

A typical SMS “push” scenario consists of the five steps detailed below:

Step 1: Prepare the Necessary Shared Folders
Create four new shared directories, named LDAP, LOGS, SJSC, and WPW, on a
computer that is part of the same SMS site as the end-user desktops. The nature of
Windows NT local accounts requires that you assign full control share permissions
for all four folders for the SMSCliToknLocalAcct$ account, as shown in the
Permissions window (left) in Figure 3-1 below.
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Figure 3-1 Permission Settings (left) and Properties (right) for the LOGS Shared Folder

These assignments will provide the necessary read/write access to these
directories for the SMS local account (which requires a password), and lets you
avoid having to open the system to guest access. Also, assign full control
permissions for all four of the NTFS folders to SMSCliToknLocalAcct$, as shown
for the LOGS folder in the Properties window (right) in Figure 3-1.

Step 2: Prepare a Connector for Microsoft
Outlook Installation Package to Install the
Necessary Software
Use the Deployment Configuration program (Admin.exe) to create an installation
package that will only install the necessary software to each user's desktop, but not
convert existing Outlook profiles and data files. The Admin.exe program is
described in Chapter 2 (“Creating End-User Installation Packages”) above, but
note these special requirements, on the Processes tab, for preparing this package
for SMS distribution:

• Be sure the User mode is set to Silent.

• Be sure to uncheck the option to Create/convert user profile.
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• Use UNC paths (\\servername\sharename) for all four of the path fields.

Step 3: Push the First Sun Java System
Installation Package to User Desktops via an
SMS Installation Package
Use Microsoft's SMS Packaging Wizard to prepare an installation package that will
contain the Sun Java System Connector installation package you created in step 2,
and then “push” the package to run automatically on user desktops — without any
user initiative or interaction.

1. Launch the SMS 2.0 Management console. Right-click on the collection to
which you want to push the Connector for Microsoft Outlook, and click
Distribute Software. SMS then launches its Distribute Software Wizard.

2. On the Distribute Software Wizard’s Welcome screen: Click Next to begin.

3. On the Package screen: Click the option to Create a new package and program,
and click Next.

4. On the Package Identification screen: Enter the appropriate values as shown in
Figure 3-2, and click Next.
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Figure 3-2 SMS Distribute Software Wizard: Package Identification

5. On the Source Files screen: Select Create a compressed version of this source,
and click Next.

6. On the Source Directory screen: Click the Browse button to locate and specify
the directory where the Connector for Microsoft Outlook installation package
was created, as shown in Figure 3-3. The path specification can be either local
or UNC. When you have specified the correct path, click Next.
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Figure 3-3 SMS Distribute Software Wizard: Source Directory Screen

7. On the Program Identification screen: Click the Browse button to locate and
specify the name of the program .exe file for the Command line, and click
Next.

8. On the Program Properties screen: Make sure the program will Run with
administrative rights, and click Next.

9. Specify whether and how you want to advertise the program on the next five
screens, titled: Advertise a Program, Advertisement Target, Advertisement
Name, Advertise to Sub collections, and Advertisement Schedule. As you enter
your choices, click Next to advance to each next screen.

10. On the Assign Program screen: Select Yes to assign the program, specify the
date and time of assignment, and click Next.
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11. On the Completing... screen: Review your settings for the creation of this
installation package. You may use the Back button to go back and change any
settings now, before you actually create the package. When the settings appear
as you want them, click Finish to create the package, which will then be
pushed to user desktops according to the Assignment and other parameters
you have specified in this Wizard.

A user’s Advertised Programs Monitor will report the package as shown in
Figure 3-4.

Figure 3-4 A User’s Advertised Programs Monitor

In any case, every user will be alerted to the imminent run of the package by a
Countdown dialog box, as shown in Figure 3-5.

Figure 3-5 A User’s Countdown Dialog Box
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Because the desktop installation program (desktop.exe) will be run by the SMS
administrator program, as a local user, access to network shares will require a
password, even if the shares are made available to the group “everyone.” If the
network denies access to log directories and install directories during a user run of
the installation package, enable guest access on the computer hosting the log files
and installation media, to allow the local account from one system to access the
data from another system.

Step 4: Prepare a Second Sun Java System
Installation Package to Convert Existing Outlook
Profiles and Data Files
Use the Sun Java System Deployment Configuration program (Admin.exe) to
create a second installation package for the Connector for Microsoft Outlook — this
time to only convert any existing Outlook profiles and data files for use with the
new Connector for Microsoft Outlook software. The Admin.exe program is
described in chapter 2 (“Creating End-User Installation Packages”) above, but note
these special requirements in the Processes tab for preparing this package:

• Set the User mode to Interactive.

• Under Processes to include in this configuration:

❍ Mark the Create/convert user profile option.

❍ Be sure that none of the Install or upgrade... options is marked.

Step 5: Push the Second Sun Java System
Installation Package to User Desktops via an
SMS Installation Package
Use Microsoft's SMS Packaging Wizard to prepare another SMS installation
package—this one to contain the Sun Java System installation package you created
in step 4. Use the same settings you used in step 3 above to prepare the first SMS
installation package, except for these differences on the Program Properties screen:

• Program can run: Select the option Only when a user is logged on.

• Mark the User input required option, and be sure that Run with
administrative rights is unmarked.
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This final SMS package will require some user interaction, to reply to password
prompts, but will not require administrator privileges since this package does not
install any new software to the desktop. The passwords will authorize the
conversion program’s access to password-protected Outlook Personal Folders
(.pst) files.

Alternatively, this step 5 can be accomplished by running the installation package
from the command line, with an SMS script, as explained below under
“Command-Line Switches for the User Installation Package.”

Command-Line Switches for the User Installation
Package

Step 5 of the “push” method described above (see ““Push” Method Deployment, If
End Users Lack Installation Privileges”) can also be accomplished by running the
installation package from an SMS script, with command-line switches to pass the
necessary user passwords to the conversion program as it runs. This would make
possible a truly silent installation and configuration, requiring no user interaction
whatsoever.

For example, you might create an SMS package that runs a conversion package,
and have the SMS services issue the following commands when it is run:

DT_Package.exe
/USERNAME=bcarpenter
/PASSWORD=password
/FULLNAME="Burns Carpenter"
/EMAILADDRESS="burns.carpenter@florizel.com"
/DN="uid=bcarpenter,ou=people,o=florizel.com,o=florizel.com"

NOTE This and other command-line samples are formatted here for ease of
reading, but all of the switches must be typed in one continuous
string — which is likely to wrap to multiple lines of its own accord.
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You could then substitute environment variables for the users (assuming that the
NT usernames and the iPlanet usernames match):

This command-line approach would permit a silent (or minimally interactive)
installation from SMS, which would probably generate far fewer Help desk calls
than asking users to click a link in an e-mail and requiring users to enter data.

The installation package will support these command-line switches:

• /USERNAME=xxx, where xxx is the username on the Sun servers.

• /PASSWORD=xxx, where xxx is the password on the Sun servers.

• /FULLNAME=xxx, where xxx is the display name of the user.

• /EMAILADDRESS=xxx, where xxx is the email address of the user.

• /DN=xxx, where xxx is the user DN on the Sun servers.

• /NEWPROFILENAME=xxx, where xxx is the name of the created profile.

• /SAVEPASSWORD=n, where n = 1 (save) or 0 (don't save).

These switches will be useful if you are converting an Exchange profile:

• /OLDDOMAIN=xxx, where xxx is the Exchange domain

• /OLDUSERNAME=xxx, where xxx is the Exchange user name

• /OLDPASSWORD=xxx, where xxx is the Exchange password

DT_Package.exe
/USERNAME=%username%
/PASSWORD=password
/FULLNAME="Change This"
/EMAILADDRESS=%username%@florizel.com
/DN=uid=%username%,ou=people,o=florizel.com,o=florizel.com
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Migrating Terminal Service Users from Exchange
to the Sun Java System

The Connector for Microsoft Outlook administrator’s tools can also be used to
migrate existing Outlook users of Windows terminal service from Exchange to a
Sun Java System server. The method described below assumes the following
environment:

• Windows 2000 Server with Terminal Services.

• Office 2000 installed with Terminal Services install file from Office 2000 Re-
source Kit CD (ORK) onto the Windows server.

• Outlook 2000 configured as the default mail client.

Step 1: Prepare the Server
Log onto the server's local console as an administrator, and configure Outlook to be
the default mail client (if it is not already). Then install Web Publishing Wizard and
the Connector for Microsoft Outlook. You will not need to install the LDAP servic-
es, because they are installed by default when using the Office 2000 Resource Kit
install file.

Step 2: Create an Appropriate Desktop
Installation Package
Use the Deployment Configuration Program to create a desktop package that does
not install any services, but simply converts profiles from Exchange to Sun Java
System services. (If the user has been in a non-Exchange environment, there will be
no profile to convert, so you must configure the desktop package to create a new
Sun Java System profile instead.)

Step 3: Update the User’s Desktop
Log on to a terminal session as a regular user, and run the desktop installation
package that you created in step 2 above — that only converts or creates a user pro-
file, but does not attempt to install or update any services. Then open Outlook and
verify that the conversion is complete.
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To Designate Microsoft Outlook as a User’s
Default E-mail Client

Sun Java System Connector for Microsoft Outlook can be installed only at
workstations where Microsoft Outlook is set to be the default e-mail client. If
Outlook is not set as a user’s default e-mail client, the Setup Wizard will not install
the software, and will prompt the user to correct the problem and run the Setup
Wizard again.

To designate Microsoft Outlook as a user’s default e-mail client (when logged in as
the user, at his or her desktop):

1. Open the Windows Control Panel. If you are running Windows XP (only):
Select “Switch to Classic View.”

2. Double-click on Internet Options.

3. Select the Programs tab from the Internet Properties window.

4. Select Microsoft Outlook from the E-mail pull-down menu.

5. Click OK.

To Remove the Sun ONE Sync Program from a
User’s Workstation

The MAPI services for the Connector for Microsoft Outlook are a required
component of the Connector installation, but cannot coexist with the Sun ONE
Sync program. If Sun ONE Sync is installed on a user’s workstation, the Setup
Wizard will notify the user of the problem (in an error message after the Welcome
screen), and prompt him or her to acknowledge the notice and exit the program.
The user may then rerun the Setup Wizard after the Sun ONE Sync program has
been removed.

To remove the Sun ONE Sync program for a user’s workstation (when logged in as
the user, at his or her desktop):

1. From the Start menu: Select Programs > Sun ONE Synchronization >
Uninstall Sun ONE Synchronization.

2. In the Uninstallation window: Follow the prompts to uninstall the software.

3. Click Finish to complete the uninstallation process.
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To synchronize a Palm device, WinCE device or Pocket PC device with Outlook,
we strongly recommend that users use the sync software distributed with their
devices, rather than the Sun ONE Synchronization software. Changing to the sync
software distributed with a device may require uninstalling and reinstalling the
Palm Desktop software.

If a user wants to continue using the Sun ONE Synchronization software to sync to
the data of the other device, he or she can reinstall the Sun ONE Synchronization
software, but not select the checkbox for the Microsoft Outlook 98/2000 translator
during the Sun ONE Synchronization installation.

Undoing (Reversing) a User’s Migration
To abandon a user’s connection to the new Sun Java System server and restore the
user’s mailbox to service with the old Exchange server:

1. Delete the profile “Xxx (old).”

2. Copy the profile “Xxx” to “Xxx Sun“— or some other name, like “Xxx (new),”
etc.

3. Delete the profile “Xxx.”

4. Copy the profile “Xxx (Backup)“to “Xxx.”

5. Delete the profile “Xxx (Backup).”

6. Determine where the .pst's are located by viewing Properties on the profile.

There is no standard location for .pst files, so the only reliable way to find
them is to open the profile (now named “Xxx”) and, for each .pst service, click
on Properties and note the path.

7. For each pst file: Rename Yyy.pst to Yyy.new, and rename Yyy.bak to
Yyy.pst.

8. Determine where the .pab's are located by viewing Properties on the profile.

There is no standard location for .pab files, so the only reliable way to find
them is to open the profile (now named “Xxx”) and, for each .pab service, click
on Properties and note the path.

9. For each pab file: Rename Zzz.pab to Zzz.new, and rename Zzz.bak to
Zzz.pab.

The Yyy.bak and Zzz.bak files will be in the same directory.



Recovering from a User’s Removal of LDAP Services from Outlook

52 Connector for Microsoft Outlook 6.0 • Desktop Deployment Configuration Program Reference Manual • February 2004

To remove the Sun Java System profile and leave the Exchange profile resident on
the system, skip step 2 (and combine steps 1 and 3).

Recovering from a User’s Removal of LDAP
Services from Outlook

If an end user manually removes LDAP services from Outlook 2000, the removal
process deletes and alters critical DLL and configuration files in ways that cannot
be “repaired” by simply reinstalling Outlook in its Repair mode. The only way to
restore LDAP services in such a case is to completely uninstall Outlook, and then
reinstall Outlook from scratch.
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